Affymetrix® Human SNP Assay 6.0 User Guide for Automated Target Preparation
For research use only.
Not for use in diagnostic procedures.

Trademarks
Affymetrix®, GeneChip®, HuSNP®, GenFlex®, Flying Objective™, CustomExpress®, CustomSeq®, NetAffx™, Tools To Take You As Far As Your Vision®, The Way Ahead™, Powered by Affymetrix®, GeneChip-compatible™, and Command Console™ are trademarks of Affymetrix, Inc.
All other trademarks are the property of their respective owners.

Limited License
Subject to the Affymetrix terms and conditions that govern your use of Affymetrix products, Affymetrix grants you a non-exclusive, non-transferable, non-sublicensable license to use this Affymetrix product only in accordance with the manual and written instructions provided by Affymetrix. You understand and agree that, except as expressly set forth in the Affymetrix terms and conditions, no right or license to any patent or other intellectual property owned or licensable by Affymetrix is conveyed or implied by this Affymetrix product. In particular, no right or license is conveyed or implied to use this Affymetrix product in combination with a product not provided, licensed, or specifically recommended by Affymetrix for such use.

Patents
Arrays: Products may be covered by one or more of the following patents and/or sold under license from Oxford Gene Technology: U.S. Patent Nos. 5,445,934; 5,700,637; 5,744,305; 5,945,334; 6,054,270; 6,140,044; 6,261,776; 6,291,183; 6,346,413; 6,399,365; 6,420,169; 6,551,817; 6,610,482; 6,733,977; and EP 619 321; 373 203 and other U.S. or foreign patents.
Reagents: Products may be covered by one or more of the following patents: U.S. Patent Nos. 6,965,020; 6,864,059.

Copyright
© 2008 Affymetrix Inc. All rights reserved.
# CONTENTS

## Chapter 1  
About Human SNP Assay 6.0 Automated Target Preparation  
- Workflows for Automated Target Preparation  
- Overview of Human SNP 6.0 Automated Target Preparation  
- User Interventions  
- Customizing a Run  
- About the GeneChip® Array Station  
- Hardware Upgrade Kit Required to Perform Human SNP 6.0 Automated Target Preparation  
- GeneChip® Array Station Control Software  
- Regulatory Compliance  
- Array Station Documentation

## Chapter 2  
Automated Target Preparation for Human SNP Assay 6.0  
- Pre-Run Check List  
- Empty the System Liquid Waste Container  
- Check the Water Supply  
- Vacuum Tubing, Waste Bottle and Filter Check  
- Load Pipet Tips  
- Clean the Arched Metal PCR Plate Lids  
- Launch the GeneChip® Array Station Control Software  
- Configure the Automated Target Preparation Run  
- Configuring the Target Preparation Setup Dialog Box  
- Configuring the Target Preparation Run Type Dialog Box  
- Run PCR Product Pooling and Purification  
- Workflow  
- Materials Required  
- Prepare the 75% EtOH  
- Prepare the Reagents  
- Set Up the Deck for PCR Product Pooling and Purification  
- PCR Product Pooling  
- PCR Product Purification  
- Run Quantitation  
- Workflow  
- Materials Required  
- Fragmentation and Labeling Reagents Required  
- Set Up the Deck for Quantitation, Fragmentation and Labeling  
- Quantitation  
- Run Fragmentation and Labeling
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow</td>
<td>34</td>
</tr>
<tr>
<td>Materials and Reagents Required</td>
<td>34</td>
</tr>
<tr>
<td>Prepare the Reagents</td>
<td>35</td>
</tr>
<tr>
<td>Fragmentation</td>
<td>35</td>
</tr>
<tr>
<td>Run Add DNA to Hybridization Mix</td>
<td>39</td>
</tr>
<tr>
<td>Workflow</td>
<td>39</td>
</tr>
<tr>
<td>Materials Required</td>
<td>39</td>
</tr>
<tr>
<td>Prepare the Reagents</td>
<td>40</td>
</tr>
<tr>
<td>Prepare the Hybridization Mix</td>
<td>41</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>45</td>
</tr>
<tr>
<td>About the Software</td>
<td></td>
</tr>
<tr>
<td>Launching the GeneChip® Array Station Control Software</td>
<td>46</td>
</tr>
<tr>
<td>Managing Users and E-mail Addresses</td>
<td>48</td>
</tr>
<tr>
<td>Adding Users and E-mail Addresses</td>
<td>48</td>
</tr>
<tr>
<td>About User Groups</td>
<td>50</td>
</tr>
<tr>
<td>Using the Calibrate Spectrophotometer Function</td>
<td>53</td>
</tr>
<tr>
<td>Appendix A</td>
<td>55</td>
</tr>
<tr>
<td>Reagents, Equipment, and Consumables</td>
<td></td>
</tr>
<tr>
<td>About this Appendix</td>
<td>55</td>
</tr>
<tr>
<td>Reagents Required</td>
<td>56</td>
</tr>
<tr>
<td>Affymetrix Reagents Required</td>
<td>56</td>
</tr>
<tr>
<td>Other Reagents Required</td>
<td>56</td>
</tr>
<tr>
<td>Equipment and Software</td>
<td>57</td>
</tr>
<tr>
<td>Affymetrix Equipment and Software Required</td>
<td>57</td>
</tr>
<tr>
<td>Other Equipment Required</td>
<td>57</td>
</tr>
<tr>
<td>Consumables Required</td>
<td>58</td>
</tr>
<tr>
<td>Supplier Contact List</td>
<td>59</td>
</tr>
<tr>
<td>Appendix B</td>
<td>61</td>
</tr>
<tr>
<td>About the Summary Report</td>
<td></td>
</tr>
<tr>
<td>Appendix C</td>
<td>65</td>
</tr>
<tr>
<td>Tips for Ensuring a Successful Run</td>
<td></td>
</tr>
<tr>
<td>Ensure Proper Sample Plate Orientation</td>
<td>66</td>
</tr>
<tr>
<td>Consistently Orient the Vacuum Collar on the Deck</td>
<td>66</td>
</tr>
<tr>
<td>Inspect the Gasket on the Vacuum Collar Before Each Run</td>
<td>66</td>
</tr>
<tr>
<td>Use the Genotyping Templates</td>
<td>67</td>
</tr>
<tr>
<td>Reconfirm all Deck Layouts</td>
<td>67</td>
</tr>
<tr>
<td>Control Static Electricity</td>
<td>67</td>
</tr>
<tr>
<td>Appendix D</td>
<td>69</td>
</tr>
<tr>
<td>Calculating Sample Concentrations</td>
<td></td>
</tr>
<tr>
<td>Formula for Calculating Sample Concentrations</td>
<td>69</td>
</tr>
<tr>
<td>Creating the File GTsample.txt</td>
<td>70</td>
</tr>
</tbody>
</table>
The Genome-Wide Human SNP Nsp/Sty 5.0/6.0 Assay was designed for use with the Affymetrix® Genome-Wide Human SNP Array 6.0 and Genome-Wide Human SNP Array 5.0. Briefly, total genomic DNA (500 ng; 250 ng each enzyme) is digested with Nsp I and Sty I restriction enzymes and ligated to adaptors that recognize the cohesive 4 bp overhangs. All fragments resulting from restriction enzyme digestion, regardless of size, are substrates for adaptor ligation. A generic primer that recognizes the adaptor sequence is used to amplify adaptor-ligated DNA fragments. PCR conditions have been optimized to preferentially amplify fragments in the 200 to 1,100 bp size range. PCR amplification products for each restriction enzyme digest are combined and purified using magnetic beads. The amplified DNA is then fragmented, labeled and hybridized to the array.

The assay can be performed manually from start to finish, or using a combination of manual and automated procedures. This user guide describes automation of the protocol using the GeneChip® Array Station.

Other topics included in this chapter:

- Workflows for Automated Target Preparation on page 2
- Overview of Human SNP 6.0 Automated Target Preparation on page 3
- About the GeneChip® Array Station on page 5
Workflows for Automated Target Preparation

Instructions for the stages performed manually are located in the *Affymetrix® Genome-Wide Human SNP Nsp/Sty 6.0 User Guide*, P/N 702504.

Table 1.1 Two Automated Target Preparation workflows

<table>
<thead>
<tr>
<th>Pre-PCR Workflow</th>
<th>Post-PCR Workflow</th>
</tr>
</thead>
</table>
| **Option A: Automated Pre-PCR on Robot**  
(not provided by Affymetrix) | **Automated Using GeneChip® Array Station** |
| **Day 1 – Digest, Ligate, PCR**  
(Pre-PCR Lab and Main Lab) | **Day 2 if Option A** (Main Lab)  
**Day 3 if Option B** (Main Lab) |
| ![Diagram of Pre-PCR Workflow](image) | ![Diagram of Post-PCR Workflow](image) |

**Option B: Manual Pre-PCR**

<table>
<thead>
<tr>
<th><strong>Day 1</strong></th>
<th><strong>Manual</strong></th>
</tr>
</thead>
</table>
| • Restriction Digest – 1 Sty Plate (Pre-PCR Lab)  
• Ligation – 1 Sty Plate (Pre-PCR Lab)  
• PCR – 3 Sty Plates (Main Lab) | **Day 3 if Option A**  
**Day 4 if Option B** |
| ![Diagram of Option B](image) | ![Diagram of Manual Process](image) |

| **Day 2** | **Day 4 if Option A**  
**Day 5 if Option B** |
|-----------|-------------------|
| • Restriction Digest – 1 Nsp Plate (Pre-PCR Lab)  
• Ligation – 1 Nsp Plate (Pre-PCR Lab)  
• PCR – 4 Nsp Plates (Main Lab) | **Wash, Stain, Scan**  
Main Lab |
| ![Diagram of Option B](image) | ![Diagram of Wash, Stain, Scan](image) |

- Hybridization onto arrays
- Wash and stain arrays
- Scan arrays
Overview of Human SNP 6.0 Automated Target Preparation

A full target preparation run for Human SNP 6.0 consists of the following:

- PCR purification (includes PCR product pooling)
- Quantitation
- Fragmentation
- Labeling
- Add DNA to Hyb Mix

Table 1.2 includes the amount of time required for a full target preparation run, as well as a breakdown of the time required for each of the procedures that comprise a full run. See also Figure 1.1 on page 4 for more information on custom runs.

At the end of target preparation, samples are ready to be denatured and hybridized onto the following arrays:

- Affymetrix® Genome-Wide Human SNP Array 6.0
- Affymetrix® Genome-Wide Human SNP Array 5.0

Table 1.2  Timeline for Human SNP Assay 6.0 Automated Target Preparation

<table>
<thead>
<tr>
<th>Full Run of 96 Samples</th>
<th>Time Elapsed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purification</strong></td>
<td></td>
</tr>
<tr>
<td>• Start PCR Purification</td>
<td>00:00</td>
</tr>
<tr>
<td>• Add first 4 PCR plates (Nsp)</td>
<td>00:03</td>
</tr>
<tr>
<td>• Add next 3 PCR plates (Sty)</td>
<td>00:04</td>
</tr>
<tr>
<td>• Check filter plate after first vacuum</td>
<td>01:13</td>
</tr>
<tr>
<td>• Centrifuge elution plate</td>
<td>01:43</td>
</tr>
<tr>
<td><strong>Quantitation through Labeling</strong></td>
<td></td>
</tr>
<tr>
<td>• Start quantitation, fragmentation, labeling</td>
<td>00:00</td>
</tr>
<tr>
<td>• Deck change for quantitation, fragmentation, labeling</td>
<td>00:02</td>
</tr>
<tr>
<td>• Read blank plate</td>
<td>00:03</td>
</tr>
<tr>
<td>• Read sample plate</td>
<td>00:04</td>
</tr>
<tr>
<td>• Time until fragmentation set up</td>
<td>00:07</td>
</tr>
<tr>
<td>• Time until labeling incubation finished</td>
<td>06:36</td>
</tr>
<tr>
<td><strong>Hybridization</strong></td>
<td></td>
</tr>
<tr>
<td>• Deck change for hybridization</td>
<td>00:00</td>
</tr>
<tr>
<td>• Hybridization complete</td>
<td>00:19</td>
</tr>
</tbody>
</table>
User Interventions

A full target preparation run requires changes to the Array Station deck for:
- PCR pooling and purification
- gDNA quantitation
- Fragmentation and Labeling
- DNA to Hybridization Mix

Customizing a Run

You have the option of stopping the run at several points. This option is typically used when running the application over multiple days. For example, PCR pooling through quantitation can be done on one day, while fragmentation through labeling are done on another.

The stop points are listed below in the *WGSA ATP Type* field of the dialog box shown in Figure 1.1. In this illustration, the user has specified that the application stop after quantitation. When a button is selected in the *WGSA ATP Type* field, the software automatically checks the appropriate boxes in the *WGSA ATP Steps* field. Notice that all of the steps from Pool PCRs through Quantitation are selected. The remaining steps are deselected.

![Figure 1.1 Customizing a run](image-url)
About the GeneChip® Array Station

The GeneChip Array Station is composed of both mechanical and software subsystems. The typical core system is shown below in Figure 1.2. The core mechanical subsystems of the Array Station include the Workstation, Bio-Rad DNA Engine® Thermal Cycler, and Twister®II Plate Stacker. Refer to the GeneChip® Array Station User’s Guide, P/N 701859, for more information.

Figure 1.2 GeneChip® Array Station typical core system
Hardware Upgrade Kit Required to Perform Human SNP 6.0 Automated Target Preparation

To perform automated target preparation for Human SNP 6.0 on the Array Station, the WGSA Automated Target Preparation Hardware Upgrade Kit is required. This upgrade must be performed by an Affymetrix Field Application Specialist.

Table 1.3  WGSA Automated Target Preparation Hardware Upgrade Kit for the GeneChip® Array Station

<table>
<thead>
<tr>
<th>Kit Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tube block, aluminum, blue (referred to as the Reagent Block)</td>
<td>1</td>
</tr>
<tr>
<td>Adapter Block, aluminum, blue</td>
<td>4</td>
</tr>
<tr>
<td>Modified GCAS Deck Locator</td>
<td>1</td>
</tr>
<tr>
<td>Genotyping Template (used on Reagent Block; Figure 1.3)</td>
<td>1</td>
</tr>
<tr>
<td>Vacuum Manifold Base</td>
<td>1</td>
</tr>
<tr>
<td>Manifold Support</td>
<td>1</td>
</tr>
<tr>
<td>Vacuum Manifold Collar</td>
<td>1</td>
</tr>
<tr>
<td>Waste Bottle Kit (tubing, bottle, fittings, filter)</td>
<td>1</td>
</tr>
<tr>
<td>Vacuum Pump Kit (valve, wires, muffler, fittings)</td>
<td>1</td>
</tr>
</tbody>
</table>

Reagent Block and Genotyping Templates

The reagent block and templates included in the WGSA Automated Target Preparation Hardware Upgrade Kit are used during fragmentation and labeling. The Reagent Block is placed on the deck of the Array Station. The appropriate template is then placed on top of the Reagent Block. The templates are provided to ensure that the reagents and empty tubes from the Human SNP 6.0 Assay Kit for Automated Target Preparation are loaded into the proper positions on the Reagent Block.

Figure 1.3  Empty Reagent Block and block with Genotyping Template for 96 samples
**GeneChip® Array Station Control Software**

The control software provides a graphical user interface (GUI) to run and track the various components that comprise the Array Station. The instrument control panels (ICPs) for each mechanical subsystem have been integrated into one GUI, thus enhancing ease of use. A schematic of the software is shown in Figure 1.4.

![Figure 1.4 Array Station control software](image)

**Regulatory Compliance**

For Array Station regulatory compliance and safety information, refer to the *GeneChip® Array Station User’s Guide*, P/N 701859.

**Array Station Documentation**

The operation of the Array Station requires familiarity with some or all of the following user documentation. The manuals that are relevant will depend upon your system configuration.

1. *GeneChip® Array Station Site Preparation Guide* (P/N 702020)
3. *Affymetrix Human SNP 6.0 Automated Target Preparation Quick Reference Card; GeneChip® Array Station Deck Layouts* (P/N 702600)
Topics included in this chapter:

- *Pre-Run Check List* on page 10
- *Launch the GeneChip® Array Station Control Software* on page 13
- *Configure the Automated Target Preparation Run* on page 14
- *Run PCR Product Pooling and Purification* on page 18
- *Run Quantitation* on page 27
- *Run Fragmentation and Labeling* on page 34
- *Run Add DNA to Hybridization Mix* on page 39

**IMPORTANT:** For optimal results, use only the reagents listed in this manual, and follow the protocol as described in this chapter. Do not substitute reagents or deviate from the protocol.
Pre-Run Check List

Empty the System Liquid Waste Container

- Empty the system liquid waste container (Figure 2.1).
- Ensure that the tubing from the system to the waste container is properly installed.

![System liquid waste container](Image)

Figure 2.1 Container for system liquid waste

Check the Water Supply

- Ensure that the water supply connections are properly installed (Figure 2.1).
- Ensure that bottles are filled with distilled or de-ionized water.
Vacuum Tubing, Waste Bottle and Filter Check

- Examine the tubing. Ensure that connections are secure. If the tubing is crimped or collapsed it must be replaced. Call your FAS. The proper tubing must be used to avoid crimping and collapses.
- Empty the vacuum liquid waste container before every run (Figure 2.2).
- Change the vacuum filter every 3 months. Mark each new filter with the date installed.

![Figure 2.2] Vacuum with tubing, filter and waste bottle.

**IMPORTANT**: Empty the vacuum liquid waste bottle before every run. Even if the bottle is not full, the waste can back up through the line and contaminate samples and other materials the deck.

Load Pipet Tips

**Static Electricity and Non-Filtered (Stacker) Tips**

If static electricity is an issue in your lab, we recommend using metal spacers between each box of stacker tips (Figure 2.3 on page 12). Metal spacers cannot be used with filter tips. See *Control Static Electricity* on page 67 for more information including the use of static guns.

**Number of Pipet Tips Required**

<table>
<thead>
<tr>
<th>Number of Samples</th>
<th>Filter Tips (blue)</th>
<th>Stacker Tips (red)</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
<td>9 racks (96 tips/rack)</td>
<td>25 maximum (96 tips/rack)</td>
</tr>
</tbody>
</table>

**Loading Filter Pipet Tips**

To load filter pipet tips:

1. Remove all boxes from rack 2 of the Twister Plate Stacker, including the base.
2. Remove the lids from the blue filter tip boxes.
3. Load the appropriate number of pipet tip boxes into rack 1 of plate stacker (Figure 2.3).
4. Place rack 1 back onto the Twister Plate Stacker, ensuring it is snapped securely in place.
5. Remove the tip base from position A5 (required for stacker tips only).

![Loading Filter or Stacker pipet tips into rack 1 of the Twister Plate Stacker.](image)

**Figure 2.3** Loading Filter or Stacker pipet tips into rack 1 of the Twister Plate Stacker.

**Loading Stacker Pipet Tips**

To load stacker pipet tips:

1. Remove empty tip boxes from rack 2 of the Twister Plate Stacker.
2. Load the appropriate number of pipet tip boxes into rack 1 of plate stacker (Figure 2.3).
   Leave rack 2 empty.
3. Place rack 1 back onto the Twister Plate Stacker, ensuring it is snapped securely in place.

**Clean the Arched Metal PCR Plate Lids**

**NOTE:** Clean the disposable pad under the arched metal lids before every run. Replace the pad every 15 runs. Refer to the GeneChip® Array Station User’s Guide for more information.

To clean the arched metal PCR plate lids:

1. Rinse the pad with DI water.
2. Wipe the pad with Ambion DNaseZap™.
3. Rinse the pad with DI water.
4. Wipe the pad with an Ambion DNaseZap® Wipe.
5. Thoroughly rinse the pad with DI water.
6. Dry the pad with pressurized clean air or nitrogen.
Launch the GeneChip® Array Station Control Software

To launch the software:

1. Launch the GeneChip® Array Station control software by double-clicking the desktop icon.
   You can also open Start > All Programs > Caliper Life Sciences > Instruments > Sciclone > GeneChip® Array Station.

2. In the Login window, enter your user name and password; then click OK.
   All runs should be done in Operator Mode.

3. To load the Human SNP 6.0 Automated Target Prep protocol:
   A. Open File > Open.
   B. In the Open Sciclone Application window, select TP_0002 and click Open.
      The protocol loads, and the operator (runtime) window appears (Figure 2.4).
   C. In the Application Control section of the window, click the Run button (Figure 2.4).
      The Target Preparation Setup dialog box appears (Figure 2.5).

4. Proceed to Configure the Automated Target Preparation Run on page 14.

Figure 2.4 Sciclone Workstation Software Operator window
Configure the Automated Target Preparation Run

The dialog boxes shown in Figure 2.5 and Figure 2.6 allow you to customize your run. Options available are described below.

Configuring the Target Preparation Setup Dialog Box

To configure the Target Preparation Setup dialog box:

1. **User name**: Open the drop-down menu and select your user name (see Managing Users and E-mail Addresses on page 48 for more information).
2. **Experiment name**: Enter a user-defined name for the experiment.
3. **Number of samples**: 96
4. **DNaseI Units (required field)**: Open the drop-down menu and select the concentration listed on the label of the GeneChip® Fragmentation Reagent tube.
5. **Read barcodes:** Select to track plate barcodes.
   - Nsp and Sty PCR product plate barcodes — you are prompted to scan or manually enter
   - Elution, fragmentation, and label plate barcodes — are scanned twice by the system during the run
   - Hyb plate — you are prompted to scan or manually enter (you can bypass if 2D barcode reader not available)

6. **Notification settings:** To receive notifications during the run:
   - Select the appropriate check boxes
   - To receive an email, select the Email button; then select an email address from the list
   - To receive a page, select the Pager button; then enter your pager number.
   - See *Managing Users and E-mail Addresses on page 48* for more information.

7. **Filter Tip boxes are in use:** Select if using pipet tips with filters. If you select this option, you cannot select **Twister II tip rack spacer plates are in use.**

   **IMPORTANT:** Be sure to select if using pipet tips with filters. Otherwise, the tips may not be picked up properly.

8. **Twister II tip rack spacer plates are in use:** Select if using metal spacer plates between tip racks. If you select this option, you cannot select **Filter Tip boxes are in use.**

   **IMPORTANT:** Be sure to select if using metal spacers plates between pipet tip racks. Otherwise, the gantry head will crash into the spacer plates and cause mechanical damage.
   - Affymetrix strongly suggests using metal spacer plates between each rack of tips and on the top rack of tips to help control static.

9. **Hold purified PCR at 4°C during user intervention:** If selected, the elution plate is moved to the thermal cycler and the eluted samples are held at 4°C indefinitely. The run proceeds once the deck is changed and you click OK.
   - If not selected, the elution plate remains on the deck until you click OK in the deck layout window.

10. **Run compressed method:** *For Affymetrix Field Application Specialist use only.*

11. Do one of the following:
   - If the entire run will be performed from start to finish on one Array Station, click **Next** and proceed to *Run PCR Product Pooling and Purification on page 18.*
   - To further customize the run, click **Customize run** and proceed to *Configuring the Target Preparation Run Type Dialog Box on page 15.*

**Configuring the Target Preparation Run Type Dialog Box**

This dialog box (Figure 2.6 on page 17) allows you to further customize the run. The two main fields in this dialog box are described below.

- **WGSA ATP Type Field**
  - The selections in this field correlate to the stop points at which the samples can be removed from the Array Station and stored before proceeding to the next step.

- **WGSA ATP Steps Field**
  - The selections in this field allow you to perform each module on its own.
To configure the Target Preparation Run Type dialog box:

1. **WGSA ATP Type** configuration options are:
   - Notice that when you select an option in this field, the corresponding steps in the WGSA ATP Steps box are selected automatically.
   - **Full target preparation**: The default selection. All steps in the WGSA ATP Steps box are selected.
   - **Partial target preparation**: To perform a partial run select one of the following:
     - **Stop after PCR purification** — will pool samples, incubate with magnetic beads, wash with EtOH, and elute. (notice the steps in the WGSA ATP Steps box that are selected automatically).
     - **Stop after quantitation** — will perform all steps from pooling samples through quantitation.
     - **Stop after adding DNA to labeling mix** — will perform all steps from pooling samples through adding DNA to the labeling mix.
     - **Stop after labeling incubation** — perform all steps from pooling through labeling incubation.
     - **Add DNA to hybridization mix only** — adds DNA to hybridization mix only

2. To pause after fragmentation to run and inspect gels, select the **Pause after fragmentation** check box.

3. **Adjust spectrophotometer values**: Select to enter a known calibration factor for your plate reader. See *Using the Calibrate Spectrophotometer Function on page 53* for more information.

4. **WGSA ATP Steps** configuration:
   - To run one or more modules individually, select the appropriate check boxes. Selecting any portion of the module will automatically select all of the check boxes for that module.

5. Click **OK**; then click **Next**.
   - The first deck layout is displayed. Proceed to *Run PCR Product Pooling and Purification on page 18*. 
Figure 2.6 Customizing the automated target preparation run

When a run type is selected in the WGS ATP Type field, the steps required for that method are selected automatically in the WGS ATP Steps field.

Example: If you select **Stop after quantitation** in the WGS ATP Type, these steps are automatically selected in the WGS ATP Steps field.

The remaining steps are automatically deselected.
Run PCR Product Pooling and Purification

Workflow

The workflow for PCR product pooling and purification is shown in Table 2.2 below.

Table 2.2  Workflow for PCR product pooling and purification

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><strong>User Intervention:</strong> Set up deck for PCR product pooling and purification.</td>
</tr>
</tbody>
</table>
| 2. | PCR products pooled and mixed with magnetic beads.  
• 100 µL each rxn on 4 Nsp plates transferred to pooling plate with magnetic beads (position D3).  
• 100 µL each rxn on 3 Sty plates transferred to pooling plate with magnetic beads  
  Total 700 µL PCR product/well.  
| 3. | Pooled PCR products incubate for 20 min at room temperature; mixed periodically.  
| 4. | PCR products transferred to filter plate and dried down. Vacuum activated during product transfer.  
• Filter plate moved to C3.  
• PCR products transferred to filter plate. Vacuum activated during transfer.  
• Dry down for 50 min. Vacuum remains on until turned off by user.  
• **User Intervention:** Prompt for additional dry down displayed twice.  
| 5. | EtOH added to each well on filter plate. Vacuum activates during addition.  
• Total 1.8 mL EtOH added to each well.  
• Dry down for 55 min.  
| 6. | Excess EtOH removed from bottom of plate.  
| 7. | Deck reconfigured automatically.  
• Vacuum collar to A3.  
• Elution plate to C3; then collar to C3 over elution plate.  
• Filter plate to C3 on top of collar to create plate stack.  
| 8. | Buffer EB added to each well of filter plate. Incubate then apply vacuum to elute samples.  
• 60 µL Buffer EB added to each well.  
• Incubate for 20 min. (During incubation, concurrent activities take place to prepare for next step.)  
• Vacuum elution for 35 min.  
• **User Intervention:** Remove plate stack from C3. Attach filter plate to elution plate. Centrifuge for 30 min at 600 rcf. Return plate stack to C3. |
Materials Required

**PCR Products Required**
- 4 Nsp plates
- 3 Sty plates

**Equipment and Consumables Required**
The materials listed in Table 2.3 assume that you are performing a full run. As such this list includes the materials required for PCR product pooling through label plate incubation.

**Table 2.3** Equipment and consumables required for PCR product pooling through label incubation

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For PCR Product Pooling, Purification and Quantitation</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>OmniTray with lid</td>
</tr>
<tr>
<td>4</td>
<td>PCR plate adapters</td>
</tr>
<tr>
<td>As required</td>
<td>Pipet tips, loaded on Twister rack 1 (leave rack 2 empty)</td>
</tr>
<tr>
<td></td>
<td>Use one of the following types of tips.</td>
</tr>
<tr>
<td></td>
<td>• Stacker tips, 200 µL (maximum 25 racks)</td>
</tr>
<tr>
<td></td>
<td>• Filter tips, 200 µL (maximum 9 racks)</td>
</tr>
<tr>
<td>IMPORTANT: Use all stacker tips or all filter tips. You cannot use both types of tips for the same run.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Filter plate, 96-well</td>
</tr>
<tr>
<td>1</td>
<td>Plate, 2.2 mL deep well storage (referred to as the pooling plate)</td>
</tr>
<tr>
<td>1</td>
<td>Plate, optical</td>
</tr>
<tr>
<td>1</td>
<td>Plate, hard-shell PCR, 96-well</td>
</tr>
<tr>
<td>1</td>
<td>Plate lid, arched metal (for filter plate)</td>
</tr>
<tr>
<td>2</td>
<td>Plate lids, microtiter</td>
</tr>
<tr>
<td>2</td>
<td>Reservoir, High Profile 300 mL</td>
</tr>
<tr>
<td>1</td>
<td>Base for stackable tip rack (if using stacker pipet tips)</td>
</tr>
<tr>
<td>1</td>
<td>Tip rack, empty, red (for lid rest)</td>
</tr>
<tr>
<td>1</td>
<td>Vacuum manifold collar</td>
</tr>
<tr>
<td>1</td>
<td>Vacuum manifold collar rest</td>
</tr>
<tr>
<td>If continuing with Fragmentation and Labeling, you will also need:</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Plates, hard-shell PCR 96-well</td>
</tr>
<tr>
<td>2</td>
<td>Plate lids, arched metal</td>
</tr>
<tr>
<td>1</td>
<td>Plate lids, microtiter (re-use from previous modules)</td>
</tr>
<tr>
<td>1</td>
<td>Reagent block, 24-position</td>
</tr>
<tr>
<td>1</td>
<td>Reservoir, High Profile 300 mL (re-use from previous modules)</td>
</tr>
</tbody>
</table>
Reagents Required

Table 2.4 Reagents required for PCR product pooling and purification on the Array Station

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Volume Required for 96 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elution Buffer (Buffer EB)</td>
<td>30 mL</td>
</tr>
<tr>
<td>EtOH, diluted to 75% with AccuGENE water</td>
<td>200 mL</td>
</tr>
<tr>
<td>Magnetic beads</td>
<td>1 mL/well</td>
</tr>
<tr>
<td>Water, AccuGENE Molecular Biology Grade</td>
<td>200 mL</td>
</tr>
</tbody>
</table>

Prepare the 75% EtOH

Dilute ACS-grade ethanol to 75% using AccuGENE water.

Prepare the Reagents

To prepare the reagents:

1. Allow the Buffer EB and 75% EtOH to warm to room temperature prior to use.
2. Aliquot 1 mL of magnetic beads to each well of a 2.2 mL deep-well plate (pooling plate).
3. To a 300 mL reservoir, add 200 mL of 75% EtOH; cover the reservoir with a universal lid.
4. To a 300 mL reservoir, add 200 mL of AccuGene water; cover the reservoir with a universal lid.
5. To an OmniTray, add 30 mL Buffer EB; cover with lid.

Set Up the Deck for PCR Product Pooling and Purification

User Intervention

To set up the deck for PCR pooling and purification:

1. Load at least 5 tip boxes in Twister Rack I (leave rack 2 empty with base only).
   Nine boxes are sufficient for full run.
2. Set up the deck as shown in Figure 2.8 on page 21.
   To verify the hardware for each position, hold the cursor over the image (Figure 2.7 on page 21).

   NOTE:
   - There should be no lid on the deep well plate with magnetic beads.
   - Orient the vacuum collar on the deck the same way each run (mark one corner).

3. Turn the vacuum switch to the On position.
   The vacuum will not begin operating until signalled by the software at the appropriate time.
4. If you have not emptied the waste bottle, empty it now.
5. Examine the gasket on the collar holder.
   The gasket should be intact, with no nicks or cuts.
6. Click Continue run.
   The system initializes, tips are transferred to the deck, and the Z8 is primed.
Figure 2.7 Hold cursor over an image in the deck layout. A description of the image appears.

Figure 2.8 Deck layout for PCR product pooling and purification

A tip rack base will be shown in position A5 if using non-filtered pipet tips.
PCR Product Pooling

User Intervention

At the prompt shown in Figure 2.9:
1. Place the four Nsp PCR plates onto the deck in positions D2, C2, B2 and B3.

   IMPORTANT: Ensure that the PCR plates are:
   • Oriented with well A1 in the top left corner.
   • Sitting flat on the adapter plate.

2. Click OK.

Figure 2.9 At this prompt, place the 4 Nsp plates onto the deck.

Automated (Nsp PCR products pooled)
• Nsp PCR products are transferred to the deep-well pooling plate in position D3.
• PCR products are mixed several times.

User Intervention

At the prompt shown in Figure 2.10:
1. Remove the four Nsp plates.
2. Place the three Sty plates onto the deck in positions D2, C2 and B2.

   IMPORTANT: Ensure that the PCR plates are:
   • Oriented with well A1 in the top left corner.
   • Sitting flat on the adapter plate.

3. Remove the plate adapter from B3.
4. Click OK.
5. Place the extra plate adapter in a –20°C freezer for at least 2 hr.
   This plate will be used during fragmentation and must be chilled for a minimum of 2 hr.
Automated (Sty PCR products pooled)

- Sty PCR products transferred to deep-well pooling plate in position D3.
- PCR products are mixed several times.
- DNA Capture: PCR products incubate at room temperature for 20 min.
  - Beads bind to DNA.
  - PCR products are mixed several times during incubation.

**PCR Product Purification**

Automated (Filter Plate dry down)

- Filter plate transferred to vacuum manifold (position C3).
- Pooled PCR products are transferred from the pooling plate to the filter plate.
  - Multiple transfers required
  - Vacuum activated during first transfer
  - Dry down for 50 min.

**IMPORTANT:** Check the vacuum pressure periodically. The pressure should remain between 20–24 in. Hg. Maximum pressure should not exceed 24 in. Hg.

**User Intervention**

To inspect the filter plate:

1. When the prompt in Figure 2.11 on page 24 is displayed, remove the filter plate from the deck and inspect the wells.
   All wells must be dry (no standing liquid).
2. Return the plate to position C3 and click **OK**.

3. At the prompt shown in **Figure 2.12**, if more vacuum time is required, enter a value in minutes.
   - If all wells are full, ensure that the:
     - Vacuum is turned on.
     - Tubing is not crimped or collapsed (call your FAS to replace if this is the problem)
     If the vacuum is on and is functioning correctly, enter 50 min.
     - If a small amount of liquid is left in one or a few wells, enter 10 min.

   ! **IMPORTANT**: Do not overdry the beads. Overdrying can result in lower yields.

4. Click **Continue**.
   If additional vacuum time was required, the prompt in **Figure 2.13** is displayed.

5. Reinspect the filter plate, then return it to position C3 and click **OK**.
6. Do one of the following:
   • If more vacuum time is required, enter a value in minutes.
   • If no extra time is required, leave the value at 0.

   **NOTE:** If liquid remains in one or several wells, you can aspirate the liquid from the clogged wells and proceed. The samples in these wells will be lost.

**Automated (Ethanol Wash)**
- EtOH transferred from reservoir (A4) to filter plate (C3) multiple times for a total transfer of 1.8 mL/well.
- Vacuum activated during first EtOH transfer and remains on for 15 min.
- Vacuum turns off, then turns on again for an additional 10 min.
- Vacuum turns off, then turns on again for an additional 5 min.
  - Concurrently, the gripper pushes the plate down gently to maintain the vacuum seal.
- Gripper picks up the filter plate and gently releases it several times to ensure all EtOH is removed from the bottom of the plate.

**IMPORTANT:** Check the vacuum pressure periodically. The pressure should remain constant between 20–24 in. Hg. Maximum pressure should not exceed 24 in. Hg.

**Automated (Elution)**
- Plates rearranged to form a plate stack on the vacuum manifold.
  - Elution plate on manifold
  - Collar over elution plate
  - Filter plate on top of collar
- Buffer EB transferred from reservoir (C5) to the filter plate for a total of 60 µL/well.
- DNA left to incubate at room temperature for 20 min.
  - Concurrently, tips are loaded in preparation for the next step.
- After incubation, the vacuum is activated for 35 min.

**IMPORTANT:** Check the vacuum pressure periodically. The pressure should remain constant between 20–24 in. Hg. Maximum pressure should not exceed 24 in. Hg.

**User Intervention**
To inspect the filter plate:

1. When the prompt in Figure 2.14 is displayed:
   - A. Remove the filter plate from the deck.
   - B. Place the filter plate on top of an elution plate and secure the plates with lab tape (Figure 2.15).

   **IMPORTANT:** Orient both plates so that well A1 is in the same corner.

   C. Using a SLOW start, centrifuge the plate stack for 30 min at 600 rcf.
2. When centrifugation is complete:
   A. Remove the tape and filter plate from the elution plate.
   B. Place an arched lid on the elution plate.
   C. Place the elution plate with arched lid in **position D5**.
   D. Click **OK**.

**Automated**

- Optional: If you selected *Hold purified PCR at 4°C during user intervention* when setting up the run, the plate of purified PCR products is moved to the thermal cycler and held at 4°C until you click **Continue** in the next deck layout window (Figure 2.16 on page 29). Otherwise, the plate remains at position D5.
Run Quantitation

Workflow

Table 2.5 Workflow for PCR product pooling and purification

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | User Intervention: Change deck layout for the OD reading.  
      |   - If continuing to fragmentation and labeling, you will also:  
      |     - Prepare the deck for these stages.  
      |     - Begin thawing the fragmentation and labeling reagents.  
| 2.   | OD reading taken.  
      |   - Water aliquoted to optical plate.  
      |   - User Intervention: Prompts for blank reading  
      |   - 2 µL each sample transferred from elution plate to optical plate  
      |   - User Intervention: Prompts for OD reading |

Materials Required

Table 2.6 Equipment and consumables required for quantitation, fragmentation and labeling

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Spectrophotometer plate reader (SpectraMax recommended)</td>
</tr>
</tbody>
</table>

Deck Layout for Quantitation

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Optical plate</td>
</tr>
<tr>
<td>1</td>
<td>Plate lid, microtiter</td>
</tr>
<tr>
<td>1</td>
<td>Reservoir, High Profile 300 mL</td>
</tr>
</tbody>
</table>

If continuing with Fragmentation and Labeling, you will also need:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Hard-shell plate, 96-well</td>
</tr>
<tr>
<td>1</td>
<td>Ice bucket with ice</td>
</tr>
<tr>
<td>2</td>
<td>Plate lids, arched metal</td>
</tr>
<tr>
<td>1</td>
<td>Plate lid, microtiter (re-use from previous quantitation module)</td>
</tr>
<tr>
<td>1</td>
<td>Reagent block, 24-position</td>
</tr>
<tr>
<td>1</td>
<td>Reservoir, High Profile 300 mL (re-use from previous quantitation module)</td>
</tr>
<tr>
<td>1</td>
<td>Template for the reagent block (96 sample)</td>
</tr>
</tbody>
</table>

About the Spectrophotometer and Sample Concentrations

The Array Station software for the TP_0002 protocol is designed for use with output from the SpectraMax microplate readers. If you have a SpectraMax, an application called HT-DNA_2µl.pda is loaded onto the computer that controls the plate reader. (The application is typically installed during system installation or during an upgrade.)

HT-DNA_2µl.pda is designed to automatically:

1. Calculate sample concentrations based on blank and standard OD readings taken at wavelengths of 260 and 320 nm.
2. Writes the values to a text file in a form that can be exported to the Array Station.
If you are using a different plate reader, you will have to manually calculate the concentration of each sample, format the results into a tab-delimited text file called \textit{GTsample.txt}, and export the file to the Array Station. Refer to Appendix D, \textit{Calculating Sample Concentrations} on page 69 for instructions.

**Fragmentation and Labeling Reagents Required**

If continuing on to fragmentation and labeling, you will begin thawing the reagents listed in Table 2.7.

<table>
<thead>
<tr>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>10X Fragmentation Buffer</td>
</tr>
<tr>
<td>GeneChip® DNA Labeling Reagent</td>
</tr>
<tr>
<td>5X Terminal Deoxynucleotidyl Transferase Buffer</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Leave all enzymes in the freezer until prompted to load onto the deck.

**Set Up the Deck for Quantitation, Fragmentation and Labeling**

To set up the deck for quantitation, fragmentation and labeling:

1. Label two 96-well hard-shell plates as follows: \textit{Frag Plate} and \textit{Label Plate}.
2. Add at least 100 mL AccuGene water to a high reservoir.
3. Change the deck layout as shown in Figure 2.16 on page 29.
   - Place the Label Plate in position A2; the Frag Plate in position A3.
   - Reservoir with water to B4. Cover with lid.
   - If proceeding to fragmentation and labeling directly after quantitation, then:
     - 24-position reagent block with reagent template to C4.
     - Turn on the Watlow temperature controller and set to 4°C.

**NOTE:** The controller requires 15 to 20 min to chill reagent block.
Some of these deck changes are in preparation for fragmentation and labeling.

4. Click Continue.
5. If proceeding to fragmentation and labeling directly after quantitation, place the following reagents on ice and allow to thaw during quantitation.
   - 10X Fragmentation Buffer
   - GeneChip® Labeling Reagent
   - 5X Terminal Deoxynucleotidyl Transferase Buffer

   ! **IMPORTANT:** Leave the Fragmentation Reagent and Terminal Deoxynucleotidyl Transferase in the freezer until ready to use.
Quantitation

Automated

- Optional: If you elected to hold purified PCR products at 4°C during user intervention, the Elution Plate is moved from the thermal cycler to D5.
- Elution plate moved from D5 to C2.
- Water transferred from reservoir to OD plate (D2) for a total of 198 µL/well.

User Intervention (Preread; Blank OD Reading)

**NOTE:** The following instructions for taking OD readings are based on the use of a SpectraMax spectrophotometer.

If you are using a different microplate spectrophotometer, you will need to calculate sample concentrations based on the formula described in Appendix D, *Calculating Sample Concentrations* on page 69.

When the prompt in Figure 2.17 on page 30 is displayed:

1. Turn on the SpectraMax spectrophotometer and allow it to warm up.
   Ensure that the LCD screen indicates that the UV lamp has successfully warmed up.
2. Start the SoftMax® Pro software and open the application HT-DNA_2µL.pda.
   File > Open > HT-DNA_2µL.pda
3. Remove the optical plate from position D2 and place it on the spectrophotometer tray.
4. In the SoftMax Pro software:
   A. Click the Read button.
   B. In the Select Section window, select Pre-read then click OK.
   C. If prompted, click Replace to Replace data in “Plate#1”?

   **NOTE:** The data displayed is from the previous reading. The data read from the blank will be displayed when Normal is selected after reading the sample ODs.

5. Return the plate to position D2, click OK.

![Figure 2.17 Prompt to take OD blank reading](image)

Automated

- Lid removed from elution plate.
- 2 µL of each well from the elution plate transferred to the OD plate.
User Intervention (Sample OD Reading)

NOTE: The following instructions for taking OD readings are based on the use of a SpectraMax spectrophotometer.

If you are using a different microplate spectrophotometer, you will need to calculate sample concentrations based on the formula described in Appendix D, Calculating Sample Concentrations on page 69.

When the prompt in Figure 2.18 is displayed:

1. Remove the optical plate from position D2 and place it on the spectrophotometer tray.

2. In the SoftMax Pro software:
   A. Click the Read button.
   B. In the Select Section window, select Normal, then click OK.
   C. If prompted, click Replace to Replace data in “Plate#1”?.

3. Export the data as GTsample.txt and transfer it to the Array Station folder C:\Affymetrix\Reader Data.

   The values are written to a text file showing concentrations and yields in µg (C:\Affymetrix\Reader Data<filename_current time/date stamp>). Results are written to a summary report as well.

4. Go to c:\\Affymetrix\\Reader Data and verify that the software has updated GTsample.txt with the correct date and time.

5. Click OK.

   The OD Viewer is displayed (example in Figure 2.19).

6. Discard the optical plate.

   Figure 2.18 Prompt to take OD reading of eluted samples
Review and Troubleshoot the OD Readings

OD readings should range between 175–300 µg. Readings are color-coded; green being within range. Wells that fall outside of this range are marked by a red box.

Table 2.8 Troubleshooting OD readings

<table>
<thead>
<tr>
<th>If the reading is:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 175</td>
<td>1. Check the OD readings by:</td>
</tr>
<tr>
<td></td>
<td>• using another reader</td>
</tr>
<tr>
<td></td>
<td>• including a standard in the plate</td>
</tr>
<tr>
<td></td>
<td>2. If the readings are accurate, determine if you should continue. Guidelines are:</td>
</tr>
<tr>
<td></td>
<td>• If all of the samples are &lt; 150, then do not proceed. Repeat the experiment.</td>
</tr>
<tr>
<td></td>
<td>• If less than 3 samples are &lt; 175, then continue. You may not want to hybridize these samples onto arrays.</td>
</tr>
<tr>
<td></td>
<td>If the experiment must be repeated, you may also want to:</td>
</tr>
<tr>
<td></td>
<td>• Check pH of magnetic beads. The pH should be 5.5. If the pH is not 5.5, repeat the experiment with fresh magnetic beads.</td>
</tr>
<tr>
<td></td>
<td>• Confirm the presence of PCR products on a gel (see the gel image in the Affymetrix® Genome-Wide Human SNP Nsp/Sty 6.0 User Guide, P/N 702504)</td>
</tr>
<tr>
<td>&gt; 300</td>
<td>1. Check the OD readings by:</td>
</tr>
<tr>
<td></td>
<td>• using another reader</td>
</tr>
<tr>
<td></td>
<td>• including a standard in the plate</td>
</tr>
<tr>
<td></td>
<td>2. If the second OD readings are high:</td>
</tr>
<tr>
<td></td>
<td>• Determine the volume in each well with an OD &gt; 300</td>
</tr>
<tr>
<td></td>
<td>• If the volume is &lt; 45 µL, bring the volume to 45 µL with Buffer EB</td>
</tr>
<tr>
<td></td>
<td>NOTE: A region of wells showing elevated yield can indicate the following.</td>
</tr>
<tr>
<td></td>
<td>• Worn gasket on the vacuum collar. Check the gasket. Replace if necessary.</td>
</tr>
</tbody>
</table>
Proceed with the Run

To proceed with the run:

1. Click Resume Run.
   The deck is cleaned up.
2. Discard the optical plate.
3. Proceed to Run Fragmentation and Labeling on page 34.
Run Fragmentation and Labeling

Workflow

**WARNING:** Do NOT pause the software at any time during the fragmentation portion of the run. If the software is paused, you will not be able to resume the run.

<table>
<thead>
<tr>
<th>Task</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>User Intervention:</strong></td>
<td></td>
</tr>
<tr>
<td>a. Thaw, vortex and spin down reagents.</td>
<td></td>
</tr>
<tr>
<td>b. Prepare the deck, including chilled adapter plate and reagents onto the reagent block.</td>
<td></td>
</tr>
<tr>
<td>2. Fragmentation Mix prepared.</td>
<td></td>
</tr>
<tr>
<td>3. Fragmentation Mix dispensed to Fragmentation Plate (D2; 10 μL/well)</td>
<td></td>
</tr>
<tr>
<td>4. Reactions transferred from Sample Plate to Fragmentation Plate</td>
<td></td>
</tr>
<tr>
<td>a. Sample plate moved to C2</td>
<td></td>
</tr>
<tr>
<td>b. 45 μL each reaction transferred from Sample plate (C2) to Fragmentation Plate (D2)</td>
<td></td>
</tr>
<tr>
<td>c. Fragmentation Mix and samples mixed.</td>
<td></td>
</tr>
<tr>
<td>5. Fragmentation Plate moved to thermal cycler and incubated for 50 min</td>
<td></td>
</tr>
<tr>
<td>6. Fragmentation Plate removed from thermal cycler to C2</td>
<td></td>
</tr>
<tr>
<td>7. Label Mix prepared and aliquoted from Reagent Block to Label Plate (D2; 19.5 μL each well).</td>
<td></td>
</tr>
<tr>
<td>8. 50.5 μL each reaction transferred from Fragmentation Plate (C2) to Label Plate (D2) and mixed.</td>
<td></td>
</tr>
<tr>
<td>9. Label Plate moved to thermal cycler and incubated for 4 hr 15 min</td>
<td></td>
</tr>
</tbody>
</table>

**Materials and Reagents Required**

**Reaction Plate Required**
One plate of pooled, purified PCR products that have been quantified.

**Materials Required**
Most of the hardware required for fragmentation and labeling was placed on the deck prior to quantitation (see Figure 2.16 on page 29). The materials listed in Table 2.10 are additional.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCR Plate Adapter, chilled at –20°C for a minimum of 2 hr (will be placed in position D2)</td>
</tr>
</tbody>
</table>
Reagents Required

Table 2.11 Reagents required

<table>
<thead>
<tr>
<th>Item</th>
<th>96 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Human SNP 6.0 Assay Kit for Automated Target Preparation</td>
<td></td>
</tr>
<tr>
<td>• GeneChip® Fragmentation Reagent**</td>
<td>1 tube**</td>
</tr>
<tr>
<td>• 10X Fragmentation Buffer</td>
<td>4 tubes</td>
</tr>
<tr>
<td>• GeneChip® DNA Labeling Reagent (DLR; 30 mM)</td>
<td>4 tubes</td>
</tr>
<tr>
<td>• Terminal Deoxynucleotidyl Transferase</td>
<td>4 tubes</td>
</tr>
<tr>
<td>• 5X Terminal Deoxynucleotidyl Transferase Buffer</td>
<td>4 tubes</td>
</tr>
<tr>
<td>• 2.0 mL tubes (black caps; empty)</td>
<td>6 tubes</td>
</tr>
<tr>
<td>• Genotyping template — 96 sample</td>
<td>1</td>
</tr>
<tr>
<td>Other reagents required</td>
<td></td>
</tr>
<tr>
<td>• Water, AccuGENE Molecular Biology Grade</td>
<td>1 bottle</td>
</tr>
</tbody>
</table>

** Each tube of GeneChip® Fragmentation Reagent contains the same volume. One tube is sufficient for 96 reactions.

Prepare the Reagents

To prepare the reagents:

1. If not thawed during quantitation, thaw the following reagents on ice now.
   - 10X Fragmentation Buffer
   - GeneChip® DNA Labeling Reagent
   - 5X Terminal Deoxynucleotidyl Transferase Buffer

   ** IMPORTANT: Leave all enzymes in the freezer until prompted to load onto the deck.**

2. Vortex and spin down the:
   - 10X Fragmentation Buffer
   - DNA Labeling Reagent
   - 5X Terminal Deoxynucleotidyl Transferase Buffer

Fragmentation

** IMPORTANT: Once you begin this stage of the protocol, do NOT pause the run until the plate is on the thermal cycler. If you pause the run, fragmentation results may be less than optimal due to loss of enzymatic activity.**

User Intervention

The placement of reagents onto the reagent block is displayed by the software (Figure 2.20) and indicated by the Genotyping Template placed on top of the Reagent Block.
When prompted to load the reagents:

1. If not already done, place the appropriate Genotyping Template onto the Reagent Block.
2. Place reagents onto the reagent block in the positions specified by the template.
3. Spin down the enzymes and place onto the Reagent Block.
   - GeneChip® Fragmentation Reagent
   - Terminal Deoxynucleotidyl Transferase
4. Place 2 mL tubes where specified by the template.

   ![IMPORTANT: Remove the cap from each tube before placing it on the deck. Push the tubes to the bottom of the wells.]

5. Place the chilled PCR Plate Adapter in position D2.
6. Click OK.

![Figure 2.20 Placement of fragmentation and labeling reagents on the reagent block]

**Automated (Fragmentation)**

⚠️ **WARNING:** Do NOT pause the software at any time during the fragmentation portion of the run. If the software is paused, you will not be able to resume the run.

- Three racks of pipet tips placed on deck in positions A1, B1 and D1.
- Z8 initializes and picks up tips.
- Fragmentation Mix prepared.
  Calculation of reagent volumes is based on the number of samples and the DNAse Units specified in the Target Preparation Setup window.
- Fragmentation Plate moved from A3 to D2.
- Lid removed from Fragmentation Plate and moved to B2.
- Fragmentation Mix picked up by Z8.
- Z8 tips touched at position D3.
- Fragmentation Mix dispensed to plate D2 (10 µL/well).
  (Z8 dispenses the mix to 48 wells x 2.)
- Lid returned to Fragmentation Plate and Z8 tips ejected.
- HVH picks up tips.
- Lid removed from Sample Plate (C2) and moved to B2.
- 45 µL each sample aspirated from C2.
- Lid removed from Fragmentation Plate and held by Gripper.
- 45 µL each sample dispensed to Fragmentation Plate and mixed.
- Lid returned to plates D2 and C2.
- Sample plate (C2) moved to A3.
- Fragmentation Plate moved from D2 to D5.
- Fragmentation Plate moved to thermal cycler by Twister.
- Samples incubated for 50 min (HT-FRAG thermal cycler program).
- After incubation, one of the following occurs:
  - If you selected Pause after fragmentation, the samples are transferred from the thermal cycler to position D5. Proceed to Optional User Intervention — Pause the Array Station to Run Fragmentation Gels below.
    If you did not select pause, you can still run fragmentation gels. Sufficient material is left in the sample plate.
  - The samples are transferred from the thermal cycler to position C2. Proceed to Automated (Labeling) on page 38.

Optional User Intervention — Pause the Array Station to Run Fragmentation Gels

If you selected Pause after fragmentation [to check fragmentation reactions on gels], the prompt in Figure 2.21 is displayed.

![Prompt displayed when Pause after fragmentation is selected.](Image)

If you did not select pause, you can still run fragmentation gels. Sufficient material is left in the sample plate.
To check the fragmentation reactions on gels:

1. Follow the instructions in the Affymetrix® Genome-Wide Human SNP Nsp/Sty 6.0 User Guide.
2. If OK to proceed, click **Continue**.
   The prompt in Figure 2.22 is displayed.
3. Return the fragmented Sample Plate to position C2 and cover with a hard-shell lid.
4. Click **OK**.

![Figure 2.22 Prompt to load plate of fragmented samples on the deck.](image)

**Automated (Labeling)**
- Label Mix is prepared.
- Label Plate moved from A2 to D2.
- Label Mix picked up by Z8.
- Z8 tips touched at position D3 (remove bubble and drop from end of each tip).
- 19.5 µL/well of Label Mix dispensed to Label Plate (D2).
  - If 96 samples, the Z8 dispenses to four columns at a time.
- Lid returned to Label Plate.
- Fragmentation Plate removed from thermal cycler by Twister and placed at D5.
- Fragmentation Plate moved to C2.
- HVH picks up tips.
- Lid removed from Fragmentation Plate (C2) to B2.
- Fragmented samples picked up from C2.
- Lid removed from Label Plate (D2) and held by Gripper.
- Fragmented samples dispensed to Label Plate and mixed (D2).
- Lids returned to Label Plate and Fragmentation Plate.
- Fragmentation Plate moved from C2 to A2.
- Z8 ejects tips.
- Label Plate moved from D2 to D5.
- Twister picks up Label Plate from D5 and moves to thermal cycler.
- Samples incubate for 4 hr 15 min (HT-LABEL thermal cycler program).
Run Add DNA to Hybridization Mix

Workflow

The transfer of prepared DNA to the hybridization mix is separate from the full target preparation run.

Table 2.12  Workflow for DNA to hybridization mix

1. *User Intervention: Prepare the Array Station deck.*
2. Sample plate moved to C2.
3. HVH transfers 190 μL of Hybridization Mix from D2 to D3.
4. 70 μL of each sample transferred to D2 and mixed.

Materials Required

**Samples Required**

One full plate of labeled samples (96).

**Materials Required**

Table 2.13  Materials required

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
<td>Caps for V-bottom tubes</td>
</tr>
<tr>
<td>1</td>
<td>OmniTray with lid</td>
</tr>
<tr>
<td>1</td>
<td>Pipet, single-channel P1000</td>
</tr>
<tr>
<td>1</td>
<td>Tip rack, empty, red (for lid rest)</td>
</tr>
<tr>
<td>1</td>
<td>Tube, 50 mL centrifuge</td>
</tr>
<tr>
<td>1 rack</td>
<td>Tube rack with 1.1 mL V-bottom tubes (referred to in deck layout as 2D tube rack)</td>
</tr>
</tbody>
</table>
Reagents Required
The following reagents are required for the Hybridization Mix. The amounts listed are sufficient to process 96 samples.

Table 2.14 Reagents Required for the Hybridization Mix

<table>
<thead>
<tr>
<th>Reagent</th>
<th>For 96 Arrays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denhardt’s Solution (50X)</td>
<td>10 mL</td>
</tr>
<tr>
<td>DMSO (100%)</td>
<td>3 mL</td>
</tr>
<tr>
<td>EDTA (0.5 M)</td>
<td>1 mL</td>
</tr>
<tr>
<td>Herring Sperm DNA (HSDNA; 10 mg/mL)</td>
<td>2 mL</td>
</tr>
<tr>
<td>Human Cot-1 DNA® (1 mg/mL)</td>
<td>1 mL</td>
</tr>
<tr>
<td>Tetramethyl Ammonium Chloride (TMACL; 5M)</td>
<td>32 mL</td>
</tr>
<tr>
<td>Tween-20 (3%)</td>
<td>20 mL</td>
</tr>
<tr>
<td>Oligo Control Reagent (OCR), 0100</td>
<td>500 µL</td>
</tr>
<tr>
<td>12X MES Stock Solution (1000 mL) consisting of:</td>
<td></td>
</tr>
<tr>
<td>• MES Hydrate SigmaUltra</td>
<td>80 g</td>
</tr>
<tr>
<td>• MES Sodium Salt</td>
<td>200 g</td>
</tr>
<tr>
<td>• Water, AccuGENE® Molecular Biology Grade</td>
<td>1L</td>
</tr>
</tbody>
</table>

Prepare the Reagents

Prepare a 12X MES Stock Solution
The 12X MES stock solution can be prepared in bulk and kept for at least one month if properly stored.
Proper storage:
- Protect from light using aluminum foil
- Keep at 4°C

! IMPORTANT: Do not autoclave. Store between 2°C and 8°C, and shield from light using aluminum foil. Discard solution if it turns yellow.

To prepare 1000 mL of 12X MES Stock Solution: (1.25 M MES, 0.89 M [Na⁺])

1. Combine:
   - 70.4 g MES hydrate
   - 193.3 g MES sodium salt
   - 800 mL AccuGENE® water
2. Mix and adjust volume to 950 mL.
3. Test the pH.
   The pH should be between 6.5 and 6.7.
4. Adjust the pH so it falls between 6.5 and 6.7.
5. Adjust the volume to 1000 mL.
6. Filter the solution through a 0.2 µm filter.
7. Protect from light using aluminum foil and store at 4°C.
Prepare the Hybridization Mix

As an option, you can prepare a larger volume of Hybridization Mix than required. The extra mix can be aliquoted and stored at –20°C for up to one week.

Preparing Fresh Hybridization Mix

To prepare the Hybridization Mix:

1. To the 50 mL centrifuge tube, add the reagents in the order shown in Table 2.15. DMSO addition: pipet directly into the solution of other reagents. Avoid pipetting along the side of the tube.
2. Mix well.
3. If making a larger volume, aliquot out 11 mL, and store the remainder at –20°C for up to one week.

Using Premixed Hybridization Mix

Hybridization Mix can be made ahead of time, aliquoted and stored for 1 week at –20°C.

To prepare stored Hybridization Mix:

1. Place the stored Hybridization Mix on the bench top, and allow to warm to room temperature.
2. Vortex at high speed until the mixture is homogeneous and without precipitates (up to 5 minutes).
3. Pulse spin for 3 sec.

Table 2.15 Hybridization Mix

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 Array</th>
<th>96 Arrays (30% extra)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MES (12X; 1.25 M)</td>
<td>12 µL</td>
<td>1500 µL</td>
</tr>
<tr>
<td>Denhardt’s Solution (50X)</td>
<td>13 µL</td>
<td>1625 µL</td>
</tr>
<tr>
<td>EDTA (0.5 M)</td>
<td>3 µL</td>
<td>375 µL</td>
</tr>
<tr>
<td>HSDNA (10 mg/mL)</td>
<td>3 µL</td>
<td>375 µL</td>
</tr>
<tr>
<td>OCR, 0100</td>
<td>2 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td>Human Cot-1 DNA* (1 mg/mL)</td>
<td>3 µL</td>
<td>375 µL</td>
</tr>
<tr>
<td>Tween-20 (3%)</td>
<td>1 µL</td>
<td>125 µL</td>
</tr>
<tr>
<td>DMSO (100%)</td>
<td>13 µL</td>
<td>1625 µL</td>
</tr>
<tr>
<td>TMACL (5 M)</td>
<td>140 µL</td>
<td>17.5 mL</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>190 µL</strong></td>
<td><strong>23.75 mL</strong></td>
</tr>
</tbody>
</table>
User Intervention

When Label Plate incubation is finished:

1. At the prompt displayed in Figure 2.23, click OK to continue.
   The Twister moves the Label Plate from the thermal cycler to D5.

![Figure 2.23 Prompt displayed when incubation for the label plate is finished.]

2. Set up the deck as shown in Figure 2.24.
3. Remove the Omnitray lid (D2), and carefully pour the Hybridization Mix into the tray.
4. Place the lid back onto Omnitray.
5. Click Continue.

![Figure 2.24 Deck layout for adding DNA to the Hybridization Mix]
Automated (DNA to Hyb Mix)
- Sample Plate moved from D5 to C2.
- HVH picks up tips and transfers 190 µL of Hybridization Mix from D2 to D3.
- HVH transfers 70 µL of labeled samples from C2 to D3.
- Samples at D3 thoroughly mixed.

User Intervention

To finish:
1. When the prompt in Figure 2.25 is displayed, click OK.
2. Remove the samples from D2 and either freeze at –20°C or continue with hybridization onto arrays.

Refer to the Affymetrix® Genome-Wide Human SNP Nsp/Sty 6.0 User Guide for instructions on:
- Loading samples onto arrays and into the hybridization oven
- Staining and washing arrays
- Scanning arrays

Figure 2.25 Prompt indicating the automated target preparation protocol is finished.
ABOUT THE SOFTWARE

Topics covered in this chapter:

• Launching the GeneChip® Array Station Control Software on page 46
• Managing Users and E-mail Addresses on page 48
• About User Groups on page 50
• Using the Calibrate Spectrophotometer Function on page 53
Launching the GeneChip® Array Station Control Software

To launch the software:

1. Launch the GeneChip® Array Station control software by double-clicking the desktop icon. You can also open Start > All Programs > Caliper Life Sciences > Instruments > Sciclone > GeneChip Array Station.

2. In the Login window, enter your user name and password; then click OK.

3. To load the Human SNP 6.0 Automated Target Prep protocol:
   A. Select File > Open.
   B. In the Open Sciclone Application window, select TP_0002 and click Open. The protocol loads, and the operator (runtime) window appears (Figure 3.1).
   C. In the Application Control section of the window, click the Run button (Figure 3.1). The Target Preparation Setup dialog box for TP_0002 appears (Figure 3.2).

4. To continue with a run, proceed to Chapter 2, Automated Target Preparation for Human SNP Assay 6.0 on page 9.

![Figure 3.1 GeneChip® Array Station software control (runtime) window](image)
Figure 3.2 Setup dialog box for Human SNP 6.0 automated target prep
Managing Users and E-mail Addresses

The software asks that you specify a user name for each run. As a user, you can also request that the application notify you via e-mail or pager when:

- User intervention is required
- Each method is finished
- The application is finished

Pager numbers are entered manually in the Target Preparation Setup dialog box for each run.

Adding Users and E-mail Addresses

To add users and e-mail addresses:

1. In the GeneChip Array Station control software, select File > Open.
2. Double-click the Accessories folder to open it.
3. Select User Names and E-mail Addresses (Figure 3.3), then click Open.

4. Click the Run button to start the script (the Manage User Names dialog box is displayed).
5. To add a new user:
   A. Click Add.
   B. Enter a name for the new user in the dialog box called Add a New Name (Figure 3.5).
   C. Click OK.
   D. Click Save and Continue to E-mails.
      The Manage E-mail Addresses dialog box is displayed (Figure 3.6).

6. To add an e-mail address:
   A. Click Add.
   B. Enter an e-mail address in the dialog box called Add a New Address (Figure 3.7).
   C. Click OK.

7. If finished, click Save and Exit.
About User Groups

GeneChip® Array Station (GCAS) control software has three user groups (Table 3.1). These groups are Operators, Developers and Administrators. Each group provides different permissions.

**Table 3.1 Permissions for GeneChip® Array Station control software**

<table>
<thead>
<tr>
<th>User Group</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCAS Operators</td>
<td>Access Runtime Window, Run Methods, Access Direct Control Window, Error Recovery</td>
</tr>
<tr>
<td>GCAS Method Developers</td>
<td>All Operator Privileges, Access Method Editor Window, Create, Edit, Save and Delete Methods, Layouts and Liquid Classes, Import and Export Applications and Methods</td>
</tr>
<tr>
<td>GCAS Administrators</td>
<td>Access all GCAS systems</td>
</tr>
</tbody>
</table>

The level of access is determined at User Login. A **User Name** and **Password** is required at login (Figure 3.8). The level of access for each authorized user is set up during system installation by Affymetrix personnel.

![Array Station Login window](image)

**Figure 3.8 Array Station Login window**

Users who belong to the Operator user group have access to the Runtime window (Figure 3.9).
Figure 3.9  Operator (Runtime) window
Users who belong to the Developer or Administrator user group have access to the Method Editor window (Tools > Switch to Editor; Figure 3.10).

![Method Editor window](image)

**Figure 3.10** Method Editor window

**NOTE:** When running Affymetrix applications, you should login as an Operator and run the applications from the runtime window (Figure 3.1).

More information on the user groups can be found in the GeneChip Array Station user’s manual.
Using the Calibrate Spectrophotometer Function

When configuring your run, you can select a parameter called *Calibrate spectrophotometer*. Selecting this option allows you to enter a known calibration factor for your plate reader.

When selected, two boxes are displayed: Standard and Expt’l. You must enter standard and experimental OD values (raw ODs or concentrations) into each box respectively.

To determine the values for each box:

1. **Standard**: Take a reading for standard DNA on another platform
2. **Expt’l**: Take a reading on the plate reader

When the plate reader data is uploaded to the Array Station control software, the data is converted immediately to values multiplied by the ratio of the inputs.

\[
\text{Conc} = \text{Conc} \times \frac{\text{Standard}}{\text{Expt'1}} \\
\text{Yield} = \text{Conc} \times \text{Volume}
\]

Values for Standard and Expt’l can range from 0 to 500. However, since dividing by 0 will crash the program, an Expt’l value of 0 is automatically converted to 0.0001. A Standard value of 0 will convert all OD data to zeroes.

**Example**

Figure 3.11 shows a sample data set run in the OD Viewer.

![Figure 3.11 Sample data set run in the OD viewer.](image-url)
Figure 3.12 Using the Calibrate spectrophotometer option with a value of 1 for Standard and 2 for Expt'.

54  Affymetrix® Human SNP Assay 6.0 User Guide for Automated Target Preparation
About this Appendix

This appendix includes the vendor and part number information for the reagents, equipment and consumables required to perform Human SNP 6.0 automated target preparation.

The following information is included in this appendix:

- Reagents Required on page 56
- Equipment and Software on page 57
- Consumables Required on page 58
- Supplier Contact List on page 59
Reagents Required

Affymetrix Reagents Required

The Affymetrix® Human SNP 6.0 Assay Kit for Automated Target Preparation is required to perform automated target preparation on the GeneChip® Array Station. The contents of one kit are sufficient to process 96 reactions or 2 x 48 reactions.

Table A.1  Affymetrix® Human SNP 6.0 Assay Kit for Automated Target Preparation, P/N 901192

<table>
<thead>
<tr>
<th>Kit Contents</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Box 1:</strong></td>
<td></td>
</tr>
<tr>
<td>- Adaptor Nsp I (50 µM)</td>
<td></td>
</tr>
<tr>
<td>- Adaptor Sty I (50 µM)</td>
<td></td>
</tr>
<tr>
<td>- PCR Primer, 002 (100 µM)</td>
<td></td>
</tr>
<tr>
<td><strong>Box 2:</strong></td>
<td></td>
</tr>
<tr>
<td>- Reference Genomic DNA, 103 (50 ng/µL)</td>
<td></td>
</tr>
<tr>
<td><strong>Box 3:</strong></td>
<td></td>
</tr>
<tr>
<td>- GeneChip® Fragmentation Reagent (unit concentration on tube label)</td>
<td></td>
</tr>
<tr>
<td>- 10X Fragmentation Buffer</td>
<td></td>
</tr>
<tr>
<td>- GeneChip® DNA Labeling Reagent (30 mM)</td>
<td></td>
</tr>
<tr>
<td>- Terminal Deoxynucleotidyl Transferase, GW 5.0</td>
<td></td>
</tr>
<tr>
<td>- 5X Terminal Deoxynucleotidyl Transferase Buffer, 30, GW 5.0</td>
<td></td>
</tr>
<tr>
<td>- Oligonucleotide Control Reagent HT</td>
<td></td>
</tr>
<tr>
<td>- Tube, 2.0 mL Skirted Polypropelene</td>
<td></td>
</tr>
<tr>
<td>- Cap, Screw Top with O’ring, Black</td>
<td></td>
</tr>
</tbody>
</table>

Other Reagents Required

Table A.2 Other Reagents Required for Human SNP 6.0 Automated Target Preparation

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Vendor</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beads, Magnetic</td>
<td>Agencourt</td>
<td>AMPure 130, 60 mL</td>
<td>000130</td>
</tr>
<tr>
<td>Buffer EB (250 mL)</td>
<td>Qiagen</td>
<td>250 ml Elution Buffer</td>
<td>19086</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Sigma-Aldrich</td>
<td>ACS reagent, 99.5% (200 proof), absolute</td>
<td>459844</td>
</tr>
<tr>
<td>Water, AccuGENE®</td>
<td>Cambrex</td>
<td>AccuGENE® Molecular Biology-Grade Water, 1 L</td>
<td>51200</td>
</tr>
</tbody>
</table>
Equipment and Software
This protocol has been optimized using the following equipment and software.

Affymetrix Equipment and Software Required

<table>
<thead>
<tr>
<th>Item</th>
<th>Part Number</th>
</tr>
</thead>
</table>
| GeneChip® Array Station | | North America and Japan (110V): 00-0162  
International (220V): 00-0235 |
| WGSA Hardware Upgrade Kit for the GeneChip® Array Station (see Hardware Upgrade Kit Required to Perform Human SNP 6.0 Automated Target Preparation on page 6 for more information) | | North America and Japan (110V): 00-0346  
International (220V): 00-0355 |
| WGSA Hardware Upgrade Kit Replacement Parts | |  |
| Adaptor block, aluminum | 11-1542 |
| Genotyping template, 96-sample | 90-0787 |

Other Equipment Required

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Quantity</th>
<th>Manufacturer/Distributor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipet-Lite™, Magnetic-Assist single channel P20</td>
<td>2</td>
<td>Rainin</td>
<td>L-20</td>
</tr>
<tr>
<td>Pipet-Lite™, Magnetic-Assist single channel P200</td>
<td>2</td>
<td>Rainin</td>
<td>L-200</td>
</tr>
<tr>
<td>Pipet-Lite™, Magnetic-Assist single channel P1000</td>
<td>2</td>
<td>Rainin</td>
<td>L-1000</td>
</tr>
<tr>
<td>Pipet, 12-channel P20 (accurate to within ± 5%)</td>
<td>2</td>
<td>Rainin</td>
<td>P/N L12-20</td>
</tr>
<tr>
<td>Pipet, 12-channel P100</td>
<td>2</td>
<td>Rainin</td>
<td>P/N L12-100</td>
</tr>
<tr>
<td>Pipet, 12-channel P200</td>
<td>2</td>
<td>Rainin</td>
<td>P/N L12-200</td>
</tr>
<tr>
<td>Pipet, 12- or 8 channel P1200</td>
<td>1</td>
<td>Rainin</td>
<td>P/N</td>
</tr>
<tr>
<td>Spectrophotometer, high throughput, microplate</td>
<td>1</td>
<td>Molecular Devices</td>
<td>SpectraMax Plus³⁸⁴</td>
</tr>
</tbody>
</table>
Consumables Required
Quantities listed are sufficient for one run of 96 samples.

Table A.5 Consumables required for Human SNP 6.0 Automated Target Preparation

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Quantity</th>
<th>Manufacturer/Distributor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lids, Universal for 96-well plates</td>
<td>2</td>
<td>Phenix Research Products</td>
<td>ML-5009</td>
</tr>
<tr>
<td>MicroAmp® Clear Adhesive Films</td>
<td>1</td>
<td>Applied Biosystems</td>
<td>4306311</td>
</tr>
<tr>
<td>OmniTrays, 90 mL with lid</td>
<td>2</td>
<td>NUNC</td>
<td>264728</td>
</tr>
<tr>
<td>Pipet tips, for use on the Array Station:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 200 µL stacker tips, automation</td>
<td>10 racks</td>
<td>Caliper Life Sciences</td>
<td>78641</td>
</tr>
<tr>
<td>• 200 µL filter tips, automation</td>
<td>10 racks</td>
<td>E &amp; K Scientific</td>
<td>EK-2783</td>
</tr>
<tr>
<td>Plate, 2.2 mL Storage, Mark II</td>
<td>1</td>
<td>ABgene</td>
<td>AB-0932</td>
</tr>
<tr>
<td>Plate, 96-well hard-shell PCR (any color shell with clear well)</td>
<td>5</td>
<td>Bio-Rad</td>
<td>HSP-9601 (white shell)</td>
</tr>
<tr>
<td>Plate, Filter, 96-well polypropylene, 2 mL PES 0.45 µM</td>
<td>1</td>
<td>E &amp; K Scientific</td>
<td>EK-2052</td>
</tr>
<tr>
<td>Plate, UV Transparent, 96-well, 370 µL</td>
<td>1</td>
<td>E &amp; K Scientific</td>
<td>EK-25801</td>
</tr>
<tr>
<td>Reservoir, deep well, high profile, 300 mL</td>
<td>2</td>
<td>E &amp; K Scientific</td>
<td>EK-2035</td>
</tr>
<tr>
<td>Storage tubes, 1.1 mL in RoboRack</td>
<td>1</td>
<td>E &amp; K Scientific</td>
<td>EK-64224</td>
</tr>
<tr>
<td>Storage tube capcluster (for capping 96 tubes)</td>
<td>1</td>
<td>E &amp; K Scientific</td>
<td>EK-64102-P</td>
</tr>
<tr>
<td>For the Vacuum Manifold</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Carboy, 1L</td>
<td>1</td>
<td>Nalgene</td>
<td>2126-1000</td>
</tr>
<tr>
<td>Carboy cap, venting</td>
<td>1</td>
<td>Nalgene</td>
<td>2162-0531</td>
</tr>
<tr>
<td>Filter, vent 0.2 µm (for vacuum manifold line)</td>
<td>1</td>
<td>VWR</td>
<td>28143-558</td>
</tr>
<tr>
<td>Quick Connect Body (female)</td>
<td>1</td>
<td>Cole-Parmer</td>
<td>K-06361-5</td>
</tr>
<tr>
<td>Quick Connect Fitting (male)</td>
<td>1</td>
<td>Cole-Parmer</td>
<td>K-06360-82</td>
</tr>
<tr>
<td>Tube, Tygon 1/4”</td>
<td>1</td>
<td>Cole-Parmer</td>
<td>EW-06429-26</td>
</tr>
</tbody>
</table>
## Supplier Contact List

<table>
<thead>
<tr>
<th>Supplier</th>
<th>Web Site Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABgene</td>
<td><a href="http://www.abgene.com">www.abgene.com</a></td>
</tr>
<tr>
<td>Affymetrix</td>
<td><a href="http://www.affymetrix.com">www.affymetrix.com</a></td>
</tr>
<tr>
<td>Agencourt Bioscience Corp.</td>
<td><a href="http://www.agencourt.com">www.agencourt.com</a></td>
</tr>
<tr>
<td>Applied Biosystems</td>
<td><a href="http://www.appliedbiosystems.com">www.appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Bio-Rad</td>
<td><a href="http://www.bio-rad.com">www.bio-rad.com</a></td>
</tr>
<tr>
<td>Caliper Life Sciences</td>
<td><a href="http://www.caliperls.com">www.caliperls.com</a></td>
</tr>
<tr>
<td>Cambrex</td>
<td><a href="http://www.cambrex.com">www.cambrex.com</a></td>
</tr>
<tr>
<td>Cole-Parmer</td>
<td><a href="http://www.coleparmer.com">www.coleparmer.com</a></td>
</tr>
<tr>
<td>E&amp;K Scientific</td>
<td><a href="http://www.eandkscientific.com">www.eandkscientific.com</a></td>
</tr>
<tr>
<td>Matrix</td>
<td><a href="http://www.matrixtechcorp.com">www.matrixtechcorp.com</a></td>
</tr>
<tr>
<td>Molecular Devices</td>
<td><a href="http://www.moleculardevices.com">www.moleculardevices.com</a></td>
</tr>
<tr>
<td>Nalgene</td>
<td><a href="http://www.nalgene.com">www.nalgene.com</a></td>
</tr>
<tr>
<td>NUNC</td>
<td><a href="http://www.nuncbrand.com">www.nuncbrand.com</a></td>
</tr>
<tr>
<td>Phenix Research Products</td>
<td><a href="http://www.phenix1.com">www.phenix1.com</a></td>
</tr>
<tr>
<td>QIAGEN</td>
<td>www1.qiagen.com</td>
</tr>
<tr>
<td>Rainin</td>
<td><a href="http://www.rainin.com">www.rainin.com</a></td>
</tr>
<tr>
<td>Sigma-Aldrich</td>
<td><a href="http://www.sigma-aldrich.com">www.sigma-aldrich.com</a></td>
</tr>
<tr>
<td>VWR</td>
<td><a href="http://www.vwr.com">www.vwr.com</a></td>
</tr>
</tbody>
</table>
ABOUT THE SUMMARY REPORT

Naming Convention:
SummaryReport_TP_0002_<date of run><time report generated>.txt

Location:
Summary reports are written to this location: C:\Affymetrix\Reports\Data

Summary Report Contents:

Table B.1  Contents of Summary Report File for Target Preparation 0002

<table>
<thead>
<tr>
<th>Report Item</th>
<th>Description</th>
<th>Example of Possible Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>Application name</td>
<td>TP_0002 WGSAX</td>
</tr>
<tr>
<td>User:</td>
<td>Name of Array Station user</td>
<td>Doe, John</td>
</tr>
<tr>
<td>Date:</td>
<td>Date run was performed</td>
<td>Tuesday, October 9, 2007</td>
</tr>
<tr>
<td>Start Time:</td>
<td>Run start time</td>
<td>9:30:31 AM</td>
</tr>
<tr>
<td>End Time:</td>
<td>Run end time</td>
<td>8:53:41 PM</td>
</tr>
<tr>
<td>Run duration:</td>
<td>Duration of run</td>
<td>4:23:10</td>
</tr>
<tr>
<td>Tracking Identifier:</td>
<td>Experiment name</td>
<td>XYZ Study 10-9-2007</td>
</tr>
<tr>
<td>Number of Samples:</td>
<td>Number of samples processed</td>
<td>96</td>
</tr>
<tr>
<td>Number of PCR Plates</td>
<td>Number of Sty and Nap Plates</td>
<td>7</td>
</tr>
<tr>
<td>DNAseI Units:</td>
<td>DNAseI Units from tube label</td>
<td>2.50</td>
</tr>
<tr>
<td>Final DNAseI concentration:</td>
<td></td>
<td>0.5 ug/ul</td>
</tr>
<tr>
<td>Calibration:</td>
<td>Adjusted spectrophotometer calibration</td>
<td>NO</td>
</tr>
<tr>
<td>Filter Tips:</td>
<td>Were tips with filters used</td>
<td>NO</td>
</tr>
<tr>
<td>Tip Spacers:</td>
<td>Were spacers used between stacker tip racks</td>
<td>NO</td>
</tr>
<tr>
<td>First Step Selected</td>
<td>First step of the run</td>
<td>Pool PCR products</td>
</tr>
<tr>
<td>Last Step Selected</td>
<td>Last step of the run</td>
<td>Add DNA to hybridization mix</td>
</tr>
</tbody>
</table>
Table B.1  (Continued) Contents of Summary Report File for Target Preparation 0002

<table>
<thead>
<tr>
<th>Report Item</th>
<th>Description</th>
<th>Example of Possible Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steps Completed:</td>
<td>Each step that was completed as part of this run</td>
<td>Pool PCR products, DNA capture, Ethanol wash, Elution, Quantitation</td>
</tr>
<tr>
<td>Pause after fragmentation:</td>
<td><em>Was Pause after fragmentation selected when configuring the run?</em></td>
<td>YES</td>
</tr>
<tr>
<td>Fragmentation timer:</td>
<td></td>
<td>5.48 minutes</td>
</tr>
<tr>
<td>Barcode Read:</td>
<td><em>Was Read barcodes selected when configuring the run?</em></td>
<td>NO</td>
</tr>
<tr>
<td>Pre-Normalization Concentrations (ug/ul)</td>
<td></td>
<td>5.5, 5.2, 5.5, etc.</td>
</tr>
<tr>
<td>Pre-Normalization Yields (ug)</td>
<td></td>
<td>257.1, 251.6, etc.</td>
</tr>
<tr>
<td>Wells with Pre-Normalization Yields outside Limits (175 ug to 300 ug)</td>
<td>List of wells with pre-normalization yields outside the limits</td>
<td>A10, A12, etc.</td>
</tr>
<tr>
<td>Error Report:</td>
<td></td>
<td><em>No errors were detected.</em></td>
</tr>
</tbody>
</table>
Example of a Summary Report

Target Preparation Summary Report
TP_0002 UGSA

User: Array User                  Date: Tuesday, October 09, 2007

Start Time: 9:06:01 AM               End Time: 10:09:36 AM
Run Duration: 25:03:05

Tracking Identifier: AlphaTest_100907

Number of Samples: 96                   Number of PCR Plates: 7
DNase I Units: 2.5                      Final DNase I concentration: 0.6μg/μl
Calibration: NO                           Tip Spacers: NO
Filter Tips: NO                           Tip Spacers: NO

First Step Selected: Pool PCRs          Last Step Selected: Add DNA to hybridization mix
Steps Completed:
Pool PCRs
DNA capture
Ethanol wash
Elution
Quantitation
Prepare fragmentation mix
Dispense fragmentation mix
Add DNA to fragmentation mix
Prepare labeling mix
Dispense labeling mix
Add DNA to labeling mix
Perform labeling incubation
Add DNA to hybridization mix

Pause after fragmentation: NO            Fragmentation time: 5.46 minutes

Figure B.1 Page 1 of summary report
Barcodes Read: NO

**Pre-Normalisation Concentrations (µg/ml)**

<table>
<thead>
<tr>
<th></th>
<th>5.6</th>
<th>5.2</th>
<th>5.5</th>
<th>4.0</th>
<th>3.4</th>
<th>5.4</th>
<th>5.1</th>
<th>5.5</th>
<th>5.3</th>
<th>3.4</th>
<th>5.7</th>
<th>0.2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.9</td>
<td>4.8</td>
<td>4.4</td>
<td>4.7</td>
<td>4.9</td>
<td>5.1</td>
<td>4.4</td>
<td>3.6</td>
<td>4.0</td>
<td>5.3</td>
<td>0.1</td>
<td>3.6</td>
</tr>
<tr>
<td></td>
<td>2.6</td>
<td>4.8</td>
<td>4.6</td>
<td>6.2</td>
<td>5.8</td>
<td>5.2</td>
<td>4.6</td>
<td>0.0</td>
<td>5.2</td>
<td>4.9</td>
<td>6.1</td>
<td>4.8</td>
</tr>
<tr>
<td></td>
<td>4.3</td>
<td>5.3</td>
<td>5.5</td>
<td>5.1</td>
<td>5.9</td>
<td>3.9</td>
<td>5.4</td>
<td>5.3</td>
<td>5.8</td>
<td>0.0</td>
<td>4.7</td>
<td>3.8</td>
</tr>
<tr>
<td></td>
<td>5.1</td>
<td>4.3</td>
<td>5.8</td>
<td>4.3</td>
<td>0.3</td>
<td>5.4</td>
<td>4.1</td>
<td>3.5</td>
<td>4.6</td>
<td>4.4</td>
<td>4.5</td>
<td>4.9</td>
</tr>
<tr>
<td></td>
<td>2.5</td>
<td>4.1</td>
<td>2.9</td>
<td>6.0</td>
<td>4.6</td>
<td>5.0</td>
<td>4.9</td>
<td>4.8</td>
<td>6.3</td>
<td>2.2</td>
<td>2.7</td>
<td>4.2</td>
</tr>
<tr>
<td></td>
<td>2.5</td>
<td>0.9</td>
<td>1.9</td>
<td>3.5</td>
<td>4.4</td>
<td>4.3</td>
<td>3.8</td>
<td>5.4</td>
<td>5.7</td>
<td>4.8</td>
<td>5.0</td>
<td>3.0</td>
</tr>
<tr>
<td></td>
<td>2.6</td>
<td>2.5</td>
<td>4.1</td>
<td>4.0</td>
<td>4.1</td>
<td>4.8</td>
<td>3.5</td>
<td>4.3</td>
<td>4.5</td>
<td>2.2</td>
<td>0.3</td>
<td>2.8</td>
</tr>
</tbody>
</table>

**Pre-Normalisation Yields (µg)**

<table>
<thead>
<tr>
<th></th>
<th>267.1</th>
<th>251.7</th>
<th>263.6</th>
<th>193.4</th>
<th>164.6</th>
<th>260.6</th>
<th>245.8</th>
<th>262.5</th>
<th>256.1</th>
<th>164.4</th>
<th>271.8</th>
<th>15.1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>282.6</td>
<td>231.1</td>
<td>212.6</td>
<td>226.6</td>
<td>232.9</td>
<td>242.7</td>
<td>212.7</td>
<td>172.3</td>
<td>192.5</td>
<td>254.7</td>
<td>3.5</td>
<td>179.2</td>
</tr>
<tr>
<td></td>
<td>122.7</td>
<td>228.7</td>
<td>221.4</td>
<td>299.2</td>
<td>279.9</td>
<td>250.6</td>
<td>218.6</td>
<td>1.2</td>
<td>251.1</td>
<td>233.4</td>
<td>292.1</td>
<td>230.3</td>
</tr>
<tr>
<td></td>
<td>206.1</td>
<td>254.6</td>
<td>254.1</td>
<td>242.0</td>
<td>255.3</td>
<td>286.9</td>
<td>257.0</td>
<td>253.0</td>
<td>280.1</td>
<td>1.3</td>
<td>225.2</td>
<td>182.3</td>
</tr>
<tr>
<td></td>
<td>243.4</td>
<td>205.7</td>
<td>278.2</td>
<td>206.9</td>
<td>12.4</td>
<td>258.2</td>
<td>197.3</td>
<td>169.0</td>
<td>220.2</td>
<td>232.9</td>
<td>221.2</td>
<td>237.7</td>
</tr>
<tr>
<td></td>
<td>220.0</td>
<td>198.5</td>
<td>137.1</td>
<td>289.8</td>
<td>221.2</td>
<td>241.3</td>
<td>235.7</td>
<td>232.7</td>
<td>301.8</td>
<td>151.7</td>
<td>178.1</td>
<td>200.0</td>
</tr>
<tr>
<td></td>
<td>169.1</td>
<td>44.3</td>
<td>91.2</td>
<td>167.1</td>
<td>210.2</td>
<td>207.9</td>
<td>181.3</td>
<td>258.8</td>
<td>274.6</td>
<td>230.0</td>
<td>241.4</td>
<td>143.4</td>
</tr>
<tr>
<td></td>
<td>124.1</td>
<td>169.9</td>
<td>197.2</td>
<td>193.9</td>
<td>195.8</td>
<td>220.2</td>
<td>169.3</td>
<td>205.8</td>
<td>217.8</td>
<td>100.5</td>
<td>12.4</td>
<td>104.9</td>
</tr>
</tbody>
</table>

**Wells with Pre-Normalisation Yields outside Limits (175µg to 300µg)**

A05  A10  A12  B08  B11  B12  C01  C08  D10  E05  E08  F01  F02  F09  F10  G01  G02  G03  G04  G12  H01  H02  H07  H10  H11  H12

Error Report: No errors were detected.

Figure B.2 Page 2 of summary report


Appendix C

TIPS FOR ENSURING A SUCCESSFUL RUN

Topics included in this chapter:

- Ensure Proper Sample Plate Orientation on page 66
- Consistently Orient the Vacuum Collar on the Deck on page 66
- Inspect the Gasket on the Vacuum Collar Before Each Run on page 66
- Use the Genotyping Templates on page 67
- Reconfirm all Deck Layouts on page 67
- Control Static Electricity on page 67
Ensure Proper Sample Plate Orientation

Sample plate orientation on the Array Station is very important — particularly when pooling samples from the Nsp and Sty plates. Mark the upper left corner of each sample plate to be used (Figure C.1).

Consistently Orient the Vacuum Collar on the Deck

We recommend that you mark one corner of the vacuum collar, and orient it on the deck the same way for each run. Using the same orientation can help troubleshoot where leaks may appear around the gasket.

Inspect the Gasket on the Vacuum Collar Before Each Run

Inspect the vacuum collar gasket before each run. Replace the gasket if:

- There are any nicks, tears, or irregularities (particularly in the corners).
- The vacuum pressure is too low or drops while performing the run.
Use the Genotyping Templates

As part of the WGSA Hardware Upgrade Kit, you received two Genotyping Templates: one for use when processing 48 samples, and one for processing 96 samples (Figure C.3). These templates are for use during fragmentation and labeling. They fit onto the Reagent Block and are designed to help ensure that the reagents and empty mixing tubes are loaded into the proper positions.

Reconfirm all Deck Layouts

Each time the deck is changed, reconfirm the layout before proceeding with the run.

Control Static Electricity

Static electricity can cause pipet tips to cling to the heads and to each other. To control static attraction, use non-sterile, RNase/DNase-free tips in combination with one of the following:

- Metal spacers between each box of tips (Figure C.4)
- Astatic gun (Figure C.5).
Figure C.5 Removing static discharge from pipet tips and boxes with a static gun
CALCULATING SAMPLE CONCENTRATIONS

The application HT-DNA_2µl.pda is designed for use with SpectraMax microplate readers. If you are using a different microplate reader, you must calculate sample concentrations based on blank and actual OD readings per the formula shown below.

To calculate sample concentrations using a different microplate reader (non-SpectraMax):

1. When prompted by the Array Station:
   A. Take blank OD readings for each well at wavelengths of 260 and 320 nm.
   B. Take diluted sample OD readings at wavelengths of 260 and 320 nm.

2. Calculate the concentration of each sample based on the blank and standard OD readings using the formula described under Formula for Calculating Sample Concentrations below.

3. Create a text file with the sample concentrations in the format described under Creating the File GTsample.txt on page 70.

4. Export the file GTsample.txt to the following folder on the Array Station computer: C:\Affymetrix\Reader Data.

   The values are written to a text file showing concentrations and yields in µg (C:\Affymetrix\Reader Data\ODs_TP_0002<current time/date stamp>). Results are written to a summary report as well.

5. Go to c:\Affymetrix\Reader Data and verify that the software has updated GTsample.txt with the correct date and time.

6. Click OK.

   The OD Viewer is displayed.

7. Discard the optical plate.

Formula for Calculating Sample Concentrations

Be sure to take blank and standard OD readings at wavelengths of 260 and 320 nm.

Formula:

\[
\text{Sample Concentration} = \left( \frac{(\text{OD}_{260,\text{Sample}} - \text{OD}_{320,\text{Sample}}) - (\text{OD}_{260,\text{Blank}} - \text{OD}_{320,\text{Blank}})}{100} \right) \times 0.05
\]

Where:

\[
(\text{OD}_{260,\text{Sample}} - \text{OD}_{320,\text{Sample}}) - (\text{OD}_{260,\text{Blank}} - \text{OD}_{320,\text{Blank}}) =
\]

- OD 260 = absorbance at 260 nm
- OD 320 = absorbance at 320 nm

100 = dilution factor (2 µL of sample diluted in 198 µL of water)

0.05 = standard DNA factor multiplier
Creating the File GTsample.txt

Once you have calculated your OD values, you must enter them into a file that can be exported to the Array Station. Follow these guidelines to create the file.

- Tab-delimited text file
- Save as GTsample.txt
- Information contained in file:
  - First three rows: enter any information you would like to include in the file
  - Rows four through 11: enter the sample concentrations in an 8 x 12 format with the first entry in row 4, indented 3 tabs from left
  - If running 48 samples, enter zero for blank wells

An example of a GTsample.txt file for 48 samples is shown in Figure D.1.

![Figure D.1](image)

Figure D.1 Example of the sample concentration file GTsample.txt